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1.  INTRODUCTION

The RCM2200 RabbitCore module is designed to be the heart of
embedded control systems. The RCM2200 features an inte-
grated Ethernet port and provides for LAN and Internet-enabled
systems to be built as easily as serial-communication systems.

The RCM2200 has a Rabbit 2000 microprocessor operating at 22.1 MHz, static RAM, 
flash memory, two clocks (main oscillator and timekeeping), and the circuitry necessary 
for reset and management of battery backup of the Rabbit 2000’s internal real-time clock 
and the static RAM. Two 26-pin headers bring out the Rabbit 2000 I/O bus lines, address 
lines, data lines, parallel ports, and serial ports.

The RCM2200 receives its +5 V power from the user board on which it is mounted. The 
RabbitCore RCM2200 can interface with all kinds of CMOS-compatible digital devices 
through the user board.

1.1  RCM2200 Features

• Small size: 1.60" × 2.30" × 0.86" 
(41 mm × 58 mm × 22 mm)

• Microprocessor: Rabbit 2000 running at 22.1 MHz

• 26 parallel I/O lines: 16 configurable for input or output, 7 fixed inputs, 3 fixed outputs 

• 8 data lines (D0–D7)

• 4 address lines (A0–A3)

• Memory I/0 read, write

• External reset input

• Five 8-bit timers (cascadable in pairs) and two 10-bit timers 

• 256K–512K flash memory, 128K–512K SRAM

• Real-time clock

• Watchdog supervisor

• Provision for customer-supplied backup battery via connections on header J5
User’s Manual 1



• 10Base-T RJ-45 Ethernet port

• Raw Ethernet and two associated LED control signals available on 26-pin header

• Three CMOS-compatible serial ports: maximum asynchronous baud rate of 691,200 bps, 
maximum synchronous baud rate of 5,529,600 bps. One port is configurable as a 
clocked port.

• Six additional I/O lines are located on the programming port, can be used as I/O lines 
when the programming port is not being used for programming or in-circuit debug-
ging—one synchronous serial port can also be used as two general CMOS inputs and 
one general CMOS output, and there are two additional inputs and one additional out-
put.

Appendix A, “RabbitCore RCM2200 Specifications,”  provides detailed specifications for 
the RCM2200.

In addition, three different RCM2200 models are available. A variant of the RCM2200, 
the RCM2300, omits the Ethernet connectivity but offers a much smaller footprint, one-
half the size of the RCM2200.

1.2  Advantages of the RCM2200

• Fast time to market using a fully engineered, “ready to run” microprocessor core.

• Competitive pricing when compared with the alternative of purchasing and assembling 
individual components.

• Easy C-language program development and debugging, including rapid production 
loading of programs.

• Generous memory size allows large programs with tens of thousands of lines of code, 
and substantial data storage.

• Integrated Ethernet port for network connectivity, royalty-free TCP/IP software.

1.3  Development and Evaluation Tools

A complete Development Kit, including a Prototyping Board and Dynamic C develop-
ment software, is available for the RCM2200. The Development Kit puts together the 
essentials you need to design an embedded microprocessor-based system rapidly and effi-
ciently.

See the RabbitCore RCM2200 Getting Started Manual for complete information on the 
Development Kit.
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1.4  How to Use This Manual

This user’s manual is intended to give users detailed information on the RCM2200 mod-
ule. It does not contain detailed information on the Dynamic C development environment 
or the TCP/IP software support for the integrated Ethernet port. Most users will want more 
detailed information on some or all of these topics in order to put the RCM2200 module to 
effective use.

1.4.1  Additional Product Information

Introductory information about the RCM2200 and its associated Development Kit and 
Prototyping Board will be found in the printed RabbitCore RCM2200 Getting Started 
Manual, which is also provided on the accompanying CD-ROM in both HTML and 
Adobe PDF format.

We recommend that any users unfamiliar with Z-World products, or those who will be 
using the Prototyping Board for initial evaluation and development, begin with at least a 
read-through of the Getting Started manual.

In addition to the product-specific information contained in the RabbitCore RCM2200 
Getting Started Manual and the RabbitCore RCM2200 User’s Manual (this manual), 
several higher level reference manuals are provided in HTML and PDF form on the 
accompanying CD-ROM. Advanced users will find these references valuable in develop-
ing systems based on the RCM2200 modules:

• Dynamic C User’s Manual

• An Introduction to TCP/IP

• Dynamic C TCP/IP User’s Manual

• Rabbit 2000 Microprocessor User’s Manual

1.4.2  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 
menu. If the icon is missing, use your browser to find and load default.htm in the docs 
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 
from our Web sites as well.
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2.  HARDWARE REFERENCE

Chapter 2 describes the hardware components and principal hardware
subsystems of the RCM2200. Appendix A, “RabbitCore RCM2200
Specifications,” provides complete physical and electrical specifica-
tions.

2.1  RCM2200 Digital Inputs and Outputs

Figure 1 shows the subsystems designed into the RCM2200.

Figure 1.  Rabbit Subsystems
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6 RabbitCore RCM2200

The RCM2200 has 26 parallel I/O lines grouped in five 8-bit ports available on headers J4 
and J5. The 16 bidirectional I/O lines are located on pins PA0–PA7, PD3–PD5, and PE0–
PE1, PE4, PE5, and PE7. The pinouts for headers J4 and J5 are shown in Figure 2.

Figure 2.  RCM2200 I/O Pinouts

2.1.1  Dedicated Inputs

PB0 is a general CMOS input when the Rabbit 2000 is either not using Serial Port B or is 
using Serial Port B in an asynchronous mode. Four other general CMOS input-only pins 
are located on PB2–PB5. These pins can also be used for the slave port. PB2 and PB3 are 
slave write and slave read strobes, while PB4 and PB5 serve as slave address lines SA0 
and SA1, and are used to access the slave registers. PC1 and PC3 are general CMOS inputs 
only. These pins can instead be selectively enabled to serve as the serial data inputs for 
Serial Ports D and C. 

2.1.2  Dedicated Outputs

One of the general CMOS output-only pins is located on PB7. PB7 can also be used with 
the slave port as the /SLAVEATTN output. This configuration signifies that the slave is 
requesting attention from the master. PC0 and PC2 are also output-only pins; PC0 and 
PC2 can instead serve as the serial data outputs for Serial Ports D and C.

2.1.3  Memory I/O Interface

Four of the Rabbit 2000 address lines (A0–A3) and all the data lines (D0–D7) are available. 
I/0 write (/IOWR) and I/0 read (/IORD) are also available for interfacing to external devices.

The ports on the Rabbit 2000 microprocessor used in the RCM2200 are configurable, and 
so the factory defaults can be reconfigured. Table 1 lists the Rabbit 2000 factory defaults 
and the alternate configurations.
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Table 1.  RCM2200 Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes

H
ea

de
r 

J4
1 GND

2 VCC

3 PC0 Output TXD

4 PC1 Input RXD

5 PC2 Output TXC

6 PC3 Input RXC

7 TPOUT–
Ethernet transmit port

8 TPOUT+

9 LNK
Ethernet link (LNK) 
LED indicator

10 PD3

Bitwise or parallel 
programmable I/O

11 PD4 ATXB output

12 PD5 ARXB input

13 /IORD
Input (I/O read 
strobe)

14 /IOWR
Output (I/O write 
strobe)

15 PE0
Bitwise or parallel 
programmable I/O

I0 control or INT0A 
input

16 PE1
I1 control or INT1A 
input

17 TPIN–
Ethernet receive port

18 TPIN+

19 PE4
Bitwise or parallel 
programmable I/O

I4 control or INT0B 
input

20 PE5
I5 control or INT1B 
input

21 ACT
Ethernet active (ACT) 
LED indicator

22 PE7
Bitwise or parallel 
programmable I/O

I7 control or slave port 
chip select /SCS

23–26 A[3:0] Rabbit 2000 address bus
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2.1.4  Other Inputs and Outputs

As shown in Table 1, pins PA0–PA7 can be used to allow the Rabbit 2000 to be a slave to 
another processor. The slave port also uses PB2–PB5, PB7, and PE7.

PE0, PE1, PE4, and PE5 can be used for up to two external interrupts. PB0 can be used to 
access the clock on Serial Port B of the Rabbit microprocessor. PD4 can be programmed 
to be a serial output for Serial Port B. PD5 can be used as a serial input by Serial Port B.

PC4, PC5, PD0, PD1, PE2, PE3, and PE6 are used for internal communication with the 
RealTek Ethernet interface chip.

H
ea

de
r 

J5

1–8 PA[0:7]
Bytewide 
programmable 
parallel I/O

Slave port data bus 
SD0–SD7

9 /RESET Reset output Reset input
This weak output can be 
driven externally

10 PB0 Input
Serial port clock CLKB 
input or output

11 PB2 Input Slave port write /SWR

12 PB3 Input Slave port read /SRD

13 PB4 Input SA0
Slave port address lines

14 PB5 Input SA1

15 PB7 Output
Slave port attention line 
/SLAVEATTN

16–23 D[7:0] Input/Output Rabbit 2000 data bus

24 VBAT 3 V battery input

25 VCC

26 GND

Table 1.  RCM2200 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
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2.2  Serial Communication

The RCM2200 board does not have an RS-232 or an RS-485 transceiver directly on the 
board. However, an RS-232 or RS-485 interface may be incorporated on the board the 
RCM2200 is mounted on. For example, the Prototyping Board supports a standard 
RS-232 transceiver chip. 

2.2.1  Serial Ports

There are four serial ports designated as Serial Ports A, B, C, and D. All four serial ports 
can operate in an asynchronous mode up to the baud rate of the system clock divided by 
64. An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an 
additional bit is sent to mark the first byte of a message, is also supported. Serial Ports A 
and B can also be operated in the clocked serial mode. In this mode, a clock line synchro-
nously clocks the data in or out. Either of the two communicating devices can supply the 
clock. When the Rabbit 2000 provides the clock, the baud rate can be up to 80% of the 
system clock frequency divided by 128, or 138,240 bps for a 22.1 MHz clock speed.

Serial Port A is available only on the programming port, and so is likely to be inconve-
nient to interface with.

2.2.2  Ethernet Port

Figure 3 shows the pinout for the RJ-45 Ethernet port (J2). Note that some Ethernet con-
nectors are numbered in reverse to the order used here.

Figure 3.  RJ-45 Ethernet Port Pinout

Two LEDs are placed next to the RJ-45 Ethernet 
jack, one to indicate an Ethernet link (LNK) and one 
to indicate Ethernet activity (ACT).

The Ethernet signals are also available on header J4. 
The ACK and LNK signals can be used to drive LEDs 
on the user board the RCM2200 is connected to.

The transformer/connector assembly ground is con-
nected to the RCM2200 printed circuit board digital 
ground via a 0 Ω resistor, R29, as shown in Figure 4.
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The RJ-45 connector is shielded to minimize EMI effects to/from the Ethernet signals. Z-
World recommends that an equivalent RJ-45 connector be used on the user board if the 
customer wishes to have an RJ-45 connector on the user board.

NOTE: The RCM2210 is available without the LEDs and the RJ-45 connector if you 
plan to use your own RJ-45 connector on your user board.

2.2.3  Programming Port

Serial Port A has special features that allow it to cold-boot the system after reset. Serial 
Port A is also the port that is used for software development under Dynamic C.

The RabbitCore RCM2200 has a 10-pin program header labeled J1. The Rabbit 2000 star-
tup-mode pins (SMODE0, SMODE1) are presented to the programming port so that an 
externally connected device can force the RCM2200 to start up in an external bootstrap 
mode. The Rabbit 2000 Microprocessor User’s Manual provides more information 
related to the bootstrap mode.

The programming port is used to start the RabbitCore RCM2200 in a mode where it will 
download a program from the port and then execute the program. The programming port 
transmits information to and from a PC while a program is being debugged in-circuit.

The RabbitCore RCM2200 can be reset from the programming port via the /RESET_IN 
line.

The Rabbit 2000 status pin is also presented to the programming port. The status pin is an 
output that can be used to send a general digital signal.

The clock line for Serial Port A is presented to the programming port, which makes syn-
chronous serial communication possible.

2.2.3.1  Alternate Uses of the Programming Port

The programming port may also be used as an application port with the DIAG connector 
on the programming cable.

All three clocked Serial Port A signals are available as

• a synchronous serial port

• an asynchronous serial port, with the clock line usable as a general CMOS input

• two general CMOS inputs and one general CMOS output.

Two startup mode pins, SMODE0 and SMODE1, are available as general CMOS inputs 
after they are read during the initial boot-up. The logic state of these two pins is very 
important in determining the startup procedure after a reset.

/RES_IN is an external input used to reset the Rabbit 2000 microprocessor.

The status pin may also be used as a general CMOS output.

See Appendix E, “Programming Cable,”  for more information.
10 RabbitCore RCM2200



2.3  Memory

2.3.1  SRAM

The RCM2200 is designed to accept 32K to 512K of SRAM packaged in an SOIC case.

2.3.2  Flash EPROM

The RCM2200 is also designed to accept 128K to 512K of flash EPROM packaged in a 
TSOP case.

NOTE: Z-World recommends that any customer applications should not be constrained 
by the sector size of the flash EPROM since it may be necessary to change the sector 
size in the future.

Writing to arbitrary flash memory addresses at run time is also discouraged. Instead, 
define a “user block” area to store persistent data. The functions writeUserBlock and 
readUserBlock are provided for this. 

A Flash Memory Bank Select jumper configuration option based on 0 Ω surface-mounted 
resistors exists at JP2, JP3, and JP5 (corresponding to the flash memory chips at U8 [second 
flash on RCM2250], U3 [RCM2200], and U7 [no flash installed on existing RCM2200 
versions]). This option, used in conjunction with some configuration macros, allows 
Dynamic C to compile two different co-resident programs for the upper and lower halves 
of the 256K flash in such a way that both programs start at logical address 0000. This is 
useful for applications that require a resident download manager and a separate down-
loaded program. See Technical Note 218, Implementing a Serial Download Manager for 
a 256K Flash, for details.

NOTE: Only the Normal Mode, which corresponds to using the full code space, is sup-
ported at the present time.

2.3.3  Dynamic C BIOS Source Files

The Dynamic C BIOS source files handle different standard RAM and flash EPROM sizes 
automatically.
User’s Manual 11



2.4  Other Hardware

2.4.1  Clock Doubler

The RCM2200 takes advantage of the Rabbit 2000 microprocessor’s internal clock dou-
bler. A built-in clock doubler allows half-frequency crystals to be used to reduce radiated 
emissions. The 22.1 MHz frequency is generated using an 11.0592 MHz crystal. The 
clock doubler is disabled automatically in the BIOS for crystals with a frequency above 
12.9 MHz.

The clock doubler may be disabled if 22.1 MHz clock speeds are not required. Disabling 
the Rabbit 2000 microprocessor’s internal clock doubler will reduce power consumption 
and further reduce radiated emissions. The clock doubler is disabled with a simple change 
to the BIOS as described below.

2.4.2  Spectrum Spreader

RCM2200 RabbitCore modules that have a Rabbit 2000 microprocessor labeled IQ4T (or 
higher) are equipped with a Rabbit 2000 microprocessor that has a spectrum spreader, 
which helps to mitigate EMI problems. By default, the spectrum spreader is on automati-
cally for RCM2200 modules that carry the IQ4T (or higher) marking when used with 
Dynamic C 7.30 or later versions, but the spectrum spreader may also be turned off or set 
to a stronger setting. The means for doing so is through a simple change to the following 
BIOS line in a way that is similar to the clock doubler described above.

#define ENABLE_SPREADER 1  // Set to 0 to disable spectrum spreader
                           // 1 to enable normal spreading, or
                           // 2 to enable strong spreading.

NOTE: The strong spectrum-spreading setting is usually not necessary for the 
RCM2200.

There is no spectrum spreader functionality for RCM2200 RabbitCore modules that have 
a Rabbit 2000 microprocessor labeled IQ1T, IQ2T, or IQ3T, or when using any RCM2200 
with a version of Dynamic C prior to 7.30.

1. Open the BIOS source code file, RABBITBIOS.C in the BIOS directory.

2. Change the line

#define CLOCK_DOUBLED 1 // set to 1 to double the clock if XTAL<=12.9MHz,

to read as follows.

#define CLOCK_DOUBLED 0 // set to 1 to double the clock if XTAL<=12.9MHz,

3. Change the serial baud rate to 57,600 bps when the RabbitCore RCM2200 is operated 
at 11.05 MHz.

4. Save the change using File > Save.
12 RabbitCore RCM2200



3.  SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Z-World controllers and other controllers
based on the Rabbit microprocessor. Chapter 3 provides the
libraries, function calls, and sample programs related to the
RCM2200.

3.1  More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging in the real 
environment. A complete reference guide to Dynamic C is contained in the Dynamic C 
User’s Manual.

You have a choice of doing your software development in the flash memory or in the static 
RAM included on the RCM2200. The advantage of working in RAM is to save wear on 
the flash memory, which is limited to about 100,000 write cycles.

NOTE: An application can be developed in RAM, but cannot run standalone from RAM 
after the programming cable is disconnected. All standalone applications can only run 
from flash memory.

NOTE: Do not depend on the flash memory sector size or type. Due to the volatility of 
the flash memory market, the RCM2200 and Dynamic C were designed to accommo-
date flash devices with various sector sizes. 

The disadvantage of using flash memory for debug is that interrupts must be disabled for 
approximately 5 ms whenever a break point is set in the program. This can crash fast inter-
rupt routines that are running while you stop at a break point or single-step the program. 
Flash memory or RAM is selected on the Options > Compiler menu.

Dynamic C Premier provides a number of debugging features. You can single-step your 
program, either in C, statement by statement, or in assembly language, instruction by 
instruction. You can set break points, where the program will stop, on any statement. You 
can evaluate watch expressions. A watch expression is any C expression that can be eval-
uated in the context of the program. If the program is at a break point, a watch expression 
can view any expression using local or external variables. If a periodic call to runwatch() 
is included in your program, you will be able to evaluate watch expressions by hitting 
<Ctrl-U> without stopping the program.
User’s Manual 13



3.2  Programming Cable
The RCM2200 is automatically in program mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in run mode when no programming cable 
is attached.

The DIAG connector of the programming cable may be used on header J5 of the RCM2200 
with the board operating in the run mode. This allows the programming port to be used as an 
application port. See Appendix E, “Programming Cable,”  for more information.

Figure 5.  Switching Between Program Mode and Run Mode

3.2.1  Changing from Program Mode to Run Mode

1. Disconnect the programming cable from header J5 of the RCM2200.

2. Reset the RCM2200. You may do this as 
explained in Figure 5.

The RCM2200 is now ready to operate in the run 
mode. 

3.2.2  Changing from Run Mode to 
Program Mode

1. Attach the programming cable to header J3 on 
the RCM2200.

2. Reset the RCM2200. You may do this as 
explained in Figure 5.

The RCM2200 is now ready to operate in the 
program mode.
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Figure 6.  Location of Reset Button
on Prototyping Board
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3.3  Dynamic C Libraries

With Dynamic C running, click File > Open, and select Lib. The following list of 
Dynamic C libraries will be displayed.

There is no unique library that is specific to the RCM2200. The functions in the above 
libraries are described in the Dynamic C User’s Manual.
User’s Manual 15



3.3.1  I/O

The RCM2200 was designed to interface with other systems, and so there are no drivers 
written specifically for the I/O. The general Dynamic C read and write functions allow 
you to customize the parallel I/O to meet your specific needs. For example, use

WrPortI(PEDDR, &PEDDRShadow, 0x00);

to set all the port E bits as inputs, or use

WrPortI(PEDDR, &PEDDRShadow, 0xFF);

to set all the Port E bits as outputs.

The sample programs in the Dynamic C SAMPLES\RCM2200 directory provide further 
examples.

3.3.1.1  PCLK Output

The PCLK output is controlled by bits 7 and 6 of the Global Output Register (GOCR) on 
the Rabbit 2000 microprocessor, and so can be enabled or disabled in software. Starting 
with Dynamic C v 7.02, the PCLK output is disabled by default at compile time to mini-
mize radiated emissions; the PCLK output is enabled in earlier versions of Dynamic C.

Use the following code to set the PCLK output as needed.

PCLK output driven with peripheral clock:

WrPortI(GOCR, &GOCRShadow, (GOCRShadow&~0xc0));

PCLK output driven with peripheral clock ÷ 2:

WrPortI(GOCR, &GOCRShadow, ((GOCRShadow&~0xc0)| 0x40));

PCLK output off (low):

WrPortI(GOCR, &GOCRShadow, ((GOCRShadow&~0xc0)| 0x80));

PCLK output on (high):

WrPortI(GOCR, &GOCRShadow, (GOCRShadow | 0xc0));

3.3.1.2  External Interrupts

The Rabbit 2000 microprocessor has four external interrupt inputs on Parallel Port E, 
which is accessed through pins PE0, PE1, PE4, and PE5 on header J4. These pins may be 
used either as I/O ports or as external interrupt inputs.

Earlier versions of the Rabbit 2000 microprocessor labeled IQ1T or IQ2T would occa-
sionally lose an interrupt request when one of the interrupt inputs was used as a pulse counter. 
See Technical Note 301, Rabbit 2000 Microprocessor Interrupt Problem, for further infor-
mation on how to work around this problem if you purchased your RCM2200 before July, 
2002, and the Rabbit 2000 microprocessor is labeled IQ1T or IQ2T.

NOTE: Interrupts on RCM2000 series RabbitCore modules sold after July, 2002, work 
correctly and do not need this workaround.
16 RabbitCore RCM2200
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3.3.2  Serial Communication Drivers

Library files included with Dynamic C provide a full range of serial communications sup-
port. The RS232.LIB library provides a set of circular-buffer-based serial functions. The 
PACKET.LIB library provides packet-based serial functions where packets can be delim-
ited by the 9th bit, by transmission gaps, or with user-defined special characters. Both 
libraries provide blocking functions, which do not return until they are finished transmit-
ting or receiving, and nonblocking functions, which must be called repeatedly until they 
are finished. For more information, see the Dynamic C User’s Manual and Technical 
Note 213, Rabbit 2000 Serial Port Software.

3.3.3  TCP/IP Drivers

The TCP/IP drivers are located in the TCPIP directory.

Complete information on these libraries and the TCP/IP functions is provided in the 
Dynamic C TCP/IP User’s Manual.
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3.4  Sample Programs

Sample programs are provided in the Dynamic C Samples folder, which is shown below.

The various folders contain specific sample programs that illustrate the use of the corre-
sponding Dynamic C libraries. For example, the sample program PONG.C demonstrates 
the output to the Dynamic C STDIO window.

Two folders contain sample programs that illustrate features unique to the RCM2200.

• RCM2200—Demonstrates the basic operation and the Ethernet functionality of the 
RCM2200.

• TCPIP—Demonstrates more advanced TCP/IP programming for Z-World’s Ethernet-
enabled Rabbit-based boards.

Follow the instructions included with the sample program to connect the RCM2200 and 
the other hardware identified in the instructions.

To run a sample program, open it with the File menu (if it is not still open), compile it 
using the Compile menu, and then run it by selecting Run in the Run menu. The 
RCM2200 must be in Program Mode (see Section 3.2, “Programming Cable”), and must 
be connected to a PC using the programming cable.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.5  Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web 
sites

• www.zworld.com/support/supportcenter.html

or

• www.rabbitsemiconductor.com/support.html

for the latest patches, workarounds, and bug fixes.

The default installation of a patch or bug fix is to install the file in a directory (folder) dif-
ferent from that of the original Dynamic C installation. Z-World recommends using a dif-
ferent directory so that you can verify the operation of the patch without overwriting the 
existing Dynamic C installation. If you have made any changes to the BIOS or to libraries, 
or if you have programs in the old directory (folder), make these same changes to the 
BIOS or libraries in the new directory containing the patch. Do not simply copy over an 
entire file since you may overwrite a bug fix; of course, you may copy over any programs 
you have written. Once you are sure the new patch works entirely to your satisfaction, you 
may retire the existing installation, but keep it available to handle legacy applications.

3.5.1  Upgrades

Dynamic C installations are designed for use with the board they are included with, and 
are included at no charge as part of our low-cost kits. Dynamic C is a complete software 
development system, but does not include all the Dynamic C features. Z-World also offers 
add-on Dynamic C modules containing the popular µC/OS-II real-time operating system, 
as well as PPP, Advanced Encryption Standard (AES), and other select libraries. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support module is also available for purchase. 
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APPENDIX A.  RABBITCORE RCM2200
SPECIFICATIONS

Appendix A provides the specifications for the RCM2200, and
describes the conformal coating.
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A.1  Electrical and Mechanical Characteristics

Figure A-1 shows the mechanical dimensions for the RCM2200.

Figure A-1.  RCM2200 Dimensions
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the 
RCM2200 in all directions when the RCM2200 is incorporated into an assembly that 
includes other printed circuit boards. This “exclusion zone” that you keep free of other 
components and boards will allow for sufficient air flow, and will help to minimize any 
electrical or EMI interference between adjacent boards. An “exclusion zone” of 0.12" 
(3 mm) is recommended below the RCM2200 when the RCM2200 is plugged into 
another assembly using the shortest connectors for headers J4 and J5. Figure A-2 shows 
this “exclusion zone.”

Figure A-2.  RCM2200 “Exclusion Zone”

�0
�	 7�
8

�0
�	 7�
8

�0
'	



7�
28

	0�2
7'�0
8

�02�
7

0�8

�0
'	



7�
'8

�0'��
7
�0'8

	0���
7
20
8

4
4


(&���"�	 
)	 �
User’s Manual 23



Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM2200.

Table A-1.  RabbitCore RCM2200 Specifications

Parameter RCM2200 RCM2210 RCM2250

Microprocessor Rabbit 2000® at 22.1 MHz

Ethernet Port
10Base-T, RJ-45,

2 LEDs
10Base-T

(raw signals only)
10Base-T, RJ-45,

2 LEDs

Flash Memory One 256K Two 256K

SRAM 128K 512K

Backup Battery
Connection for user-supplied backup battery

(to support RTC and SRAM)

General-Purpose I/O

26 parallel I/0 lines grouped in five 8-bit ports (shared with serial ports):

• 16 configurable I/O
•  7 fixed inputs
•  3 fixed outputs

Additional Inputs 2 startup mode, reset

Additional Outputs Status, reset

Memory, I/O Interface 4 address lines, 8 data lines, I/O read/write

Serial Ports
Four 5 V CMOS-compatible ports.

Two ports are configurable as clocked ports, one is a dedicated RS-232 
programming port.

Serial Rate
Maximum burst rate = CLK/32

Maximum sustained rate = CLK/64

Slave Interface
A slave port allows the RCM2200 to be used as an intelligent peripheral 
device slaved to a master processor, which may either be another Rabbit 
2000 or any other type of processor

Real-Time Clock Yes

Timers
Five 8-bit timers cascadable in pairs, one 10-bit timer with 2 match 

registers that each have an interrupt

Watchdog/Supervisor Yes

Power  4.75 V to 5.25 V DC, 134 mA

Operating Temperature –40°C to +70°C

Humidity 5% to 95%, noncondensing

Connectors Two IDC headers 2 × 13, 2 mm pitchs

Board Size
1.60" × 2.30" × 0.86"

(41 mm × 59 mm × 22 mm)
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A.1.1  Headers

The RCM2200 uses headers at J4 and J5 for physical connection to other boards. J4 and J5 
are 2 × 13 SMT headers with a 2 mm pin spacing. J1, the programming port, is a 2 × 5 
header with a 2 mm pin spacing.

Figure A-3 shows the layout of another board for the RCM2200 to be plugged into. These 
values are relative to the header connectors.

A.1.2  Physical Mounting

A 9/32” (7 mm) standoff with a 4-40 screw is recommended to attach the RCM2200 to a 
user board at the hole position shown in Figure A-3. Either use plastic hardware, or use 
insulating washers to keep any metal hardware from shorting out signals on the RCM2200.

Figure A-3.  User Board Footprint for RCM2200
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A.2  Bus Loading

You must pay careful attention to bus loading when designing an interface to the 
RCM2200. This section provides bus loading information for external devices.

Table A-2 lists the capacitance for the various RCM2200 I/O ports.

Table A-2.  Capacitance of Rabbit 2000 I/O Ports

I/O Ports
Input 

Capacitance
(pF)

Output 
Capacitance

(pF)

Parallel Ports A to E 12 14

Data Lines BD0–BD7 10 12

Address Lines BA0–BA12 4 8
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Figure A-4 shows a typical timing diagram for the Rabbit 2000 microprocessor external 
memory read and write cycles.

Figure A-4.  Memory Read and Write Cycles

Tadr is the time required for the address output to reach 0.8 V. This time depends on the 

bus loading. Tsetup is the data setup time relative to the clock. Tsetup is specified from 

30%/70% of the VDD voltage level.
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Table A-3 lists the parameters shown in these figures and provides minimum or measured 
values.

A.3  Rabbit 2000 DC Characteristics

Table A-4 outlines the DC characteristics for the Rabbit 2000 at 5.0 V over the recom-
mended operating temperature range from Ta = –40°C to +85°C, VDD = 4.5 V to 5.5 V.

Table A-3.  Memory and External I/O Read/Write Parameters

Parameter Description Value

R
ea

d 
P

ar
am

et
er

s

Tadr
Time from CPU clock rising 
edge to address valid

Max.
7 ns @ 20 pF, 5 V
14 ns @ 70 pF, 5 V

Tsetup Data read setup time Min. 2 ns @ 5 V

Thold Data read hold time Min. 0 ns

W
ri

te
 P

ar
am

et
er

s Tadr
Time from CPU clock rising 
edge to address valid

Max.
7 ns @ 20 pF, 5 V
14 ns @ 70 pF, 5 V

Thold
Data write hold time from /WEx 
or /IOWR

Min. ½ CPU clock cycle

Table A-4.  5.0 Volt DC Characteristics

Symbol Parameter Test Conditions Min Typ Max Units

IIH Input Leakage High VIN = VDD, VDD = 5.5 V 10 µA

IIL
Input Leakage Low
(no pull-up)

VIN = VSS, VDD = 5.5 V -10 µA

IOZ Output Leakage (no pull-up)
VIN = VDD or VSS, 
VDD = 5.5 V

-10 10 µA

VIL CMOS Input Low Voltage 0.3 x VDD V

VIH CMOS Input High Voltage 0.7 x VDD V

VT CMOS Switching Threshold VDD = 5.0 V, 25°C 2.4 V

VOL CMOS Output Low Voltage

IOL = See Table A-5 
(sinking)

 VDD = 4.5 V
0.2 0.4 V

VOH CMOS Output High Voltage

IOH = See Table A-5 
(sourcing)

 VDD = 4.5 V

0.7 x VDD 4.2 V
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A.4  I/O Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit I/O buffers are capable of sourcing and sinking 
8 mA of current per pin at full AC switching speed. Full AC switching assumes a 
25.8 MHz CPU clock and capacitive loading on address and data lines of less than 100 pF 
per pin. Address pin A0 and data pin D0 are rated at 16 mA each. Pins A1–A12 and D1–D7 
are each rated at 8 mA. The absolute maximum operating voltage on all I/O is VDD + 0.5 V 

or 5.5 V.

Table A-5 shows the AC and DC output drive limits of the parallel I/O buffers when the 
Rabbit 2000 is used in the RCM2200.

Table A-5.  I/O Buffer Sourcing and Sinking Capability

Pin Name

Output Drive

Sourcing*/Sinking† Limits
(mA)

* The maximum DC sourcing current for I/O buffers between VDD 

pins is 112 mA.

† The maximum DC sinking current for I/O buffers between VSS 
pins is 150 mA.

Output Port Name
Full AC Switching

SRC/SNK

Maximum‡ DC Output 
Drive

SRC/SNK

‡ The maximum DC output drive on I/O buffers must be adjusted to 
take into consideration the current demands made my AC switch-
ing outputs, capacitive loading on switching outputs, and switching 
voltage.

 The current drawn by all switching and nonswitching I/O must 
not exceed the limits specified in the first two footnotes.

PA [7:0] 8/8 12/12

PB [7:6] 8/8 12/12

PC [6, 2, 0] 8/8 12/12

PD [5:4] 8/8 12/12

PD [3:0]**

** The combined sourcing from Port D [7:0] may need to be adjusted 
so as not to exceed the 112 mA sourcing limit requirement speci-
fied in Note 1.

16/16 25/25

PE [7, 5, 4, 1, 0] 8/8 12/12
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A.5  Jumper Configurations

Figure A-5 shows the header locations used to configure the various RCM2200 options 
via jumpers. 

Figure A-5.  Location of RCM2200 Configurable Positions

Table A-6 lists the configuration options.

NOTE: The jumper connections are made using 0 Ω surface-mounted resistors.

Table A-6.  RCM2100 Jumper Configurations

Header Description Pins Connected
Factory 
Default

JP1
Flash Memory Size
(U8—RCM2250 only))

1–2 128K/256K ×
2–3 512K

JP2
Flash Memory Bank Select
(U8—RCM2250 only)

1–2 Normal Mode ×
2–3 Bank Mode

JP3
Flash Memory Bank Select
(U3)

1–2 Normal Mode ×
2–3 Bank Mode

JP4 Flash Memory Size (U3)
1–2 128K/256K ×
2–3 512K

JP5
Flash Memory Bank Select
(U7—not installed)

1–2 Normal Mode
—

2–3 Bank Mode

JP6
Flash Memory Size
(U7—not installed)

1–2 128K/256K
—

2–3 512K

JP7 SRAM Size
1–2 128K

RCM2200
RCM2210

2–3 512K RCM2250
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A.6  Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator has had the Dow Corning 
silicone-based 1-2620 conformal coating applied. The conformally coated area is shown 
in Figure A-6. The conformal coating protects these high-impedance circuits from the 
effects of moisture and contaminants over time.

Figure A-6.  RCM2200 Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering 
procedures for surface-mounted components. A new conformal coating should then be 
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note 303, Con-
formal Coatings.
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APPENDIX B.  PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board, and explains the use of the Prototyping Board to
demonstrate the RCM2200 and to build prototypes of your own
circuits.
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B.1  Mechanical Dimensions and Layout

Figure B-1 shows the mechanical dimensions and layout for the RCM2200 Prototyping Board.

Figure B-1.  RCM2200 Prototyping Board Dimensions

Table B-1 lists the electrical, mechanical, and environmental specifications for the Proto-
typing Board.

Table B-1.  RCM2200 Prototyping Board Specifications

Parameter Specification

Board Size 4.25" × 5.25" × 1.00" (108 mm × 133 mm × 25 mm)

Operating Temperature –40°C to +70°C

Humidity 5% to 95%, noncondensing

Input Voltage 7.5 V to 25 V DC

Maximum Current Draw
(including user-added circuits)

1 A at 12 V and 25°C, 0.7 A at 12 V and 70ºC

Prototyping Area
2.4" × 4.0" (61 mm × 102 mm) throughhole, 0.1" spacing, 
additional space for SMT components

Standoffs/Spacers 4, accept 6-32 × 3/8 screws
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B.2  Power Supply

The RCM2200 requires a regulated 5 V ± 0.25 V DC power source to operate. Depending 
on the amount of current required by the application, different regulators can be used to 
supply this voltage.

The Prototyping Board has an onboard 7805 or equivalent linear regulator that is easy to 
use. Its major drawback is its inefficiency, which is directly proportional to the voltage 
drop across it. The voltage drop creates heat and wastes power.

A switching power supply may be used in applications where better efficiency is desir-
able. The LM2575 is an example of an easy-to-use switcher. This part greatly reduces the 
heat dissipation of the regulator. The drawback in using a switcher is the increased cost. 

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2 
as shown in Figure B-2. 

Figure B-2.  Prototyping Board Power Supply

B.3  Using the Prototyping Board

The Prototyping Board is actually both a demonstration board and a prototyping board. As 
a demonstration board, it can be used to demonstrate the functionality of the RCM2200 
right out of the box without any modifications to either board. There are no jumpers or dip 
switches to configure or misconfigure on the Prototyping Board so that the initial setup is 
very straightforward.

The Prototyping Board comes with the basic components necessary to demonstrate the 
operation of the RCM2200. Two LEDs (DS2 and DS3) are connected to PE1 and PE7, and 
two switches (S2 and S3) are connected to PB2 and PB3 to demonstrate the interface to 
the Rabbit 2000 microprocessor. Reset switch S1 is the hardware reset for the RCM2200.
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To maximize the availability of RCM2200 resources, the demonstration hardware (LEDs 
and switches) on the Prototyping Board may be disconnected. This is done by cutting the 
traces below the silk-screen outline of header JP1 on the bottom side of the Prototyping 
Board. Figure B-3 shows the four places where cuts should be made. Cut the traces 
between the rows as shown. An exacto knife would work nicely to cut the traces. Alterna-
tively, a small standard screwdriver may be carefully and forcefully used to wipe through 
the PCB traces.

Figure B-3.  Where to Cut Traces to Permanently Disable 
Demonstration Hardware on Prototyping Board

The power LED (PWR) and the RESET switch remain connected. Jumpers across the 
appropriate pins on header JP1 can be used to reconnect specific demonstration hardware 
later if needed.

Note that the pinout at location JP1 on the bottom side of the Prototyping Board (shown in 
Figure B-3) is a mirror image of the top-side pinout.

The Prototyping Board provides the user with RCM2200 connection points brought out con-
veniently to labeled points at headers J7 and J8 on the Prototyping Board. Small to medium 
circuits can be prototyped using point-to-point wiring with 20 to 30 AWG wire between the 

Table B-2.  Prototyping Board Jumper Settings

Header JP1

Pins Description

1–2 PE1 to LED DS2

3–4 PE7 to LED DS3

5–6 PB2 to Switch S2

7–8 PB3 to Switch S3
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prototyping area and the holes at locations J7 and J8. The holes are spaced at 0.1" (2.5 mm), 
and 40-pin headers or sockets may be installed at J7 and J8. The pinouts for locations J7 and 
J8, which correspond to headers J1 and J2, are shown in Figure B-4.

Figure B-4.  RCM2200 Prototyping Board Pinout
(Top View)

The small holes are also provided for surface-mounted components that may be installed 
to the right of the prototyping area.

There is a 2.4" × 4" through-hole prototyping space available on the Prototyping Board. 
VCC and GND traces run along the edge of the Prototyping Board for easy access. A 
GND pad is also provided at the lower right for alligator clips or probes.

Figure B-5.  VCC and GND Traces Along Edge of Prototyping Board
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B.3.1  Adding Other Components

There is room on the Prototyping Board for a user-supplied RS-232 transceiver chip at 
location U2 and a 10-pin header for serial interfacing to external devices at location J6. A 
Maxim MAX232 transceiver is recommended. When adding the MAX232 transceiver at 
position U2, you must also add 100 nF charge storage capacitors at positions C3–C7 as 
shown in Figure B-6.

Figure B-6.  Location for User-Supplied RS-232 Transceiver
and Charge Storage Capacitors on Back Side of Prototyping Board

NOTE: The board that is supplied with the DeviceMate Development Kit already has the 
RS-232 chip and the storage capacitors installed, and is called the DeviceMate Demon-
stration Board.

There are two sets of pads that can be used for surface mount prototyping SOIC devices. 
The silk screen layout separates the rows into six 16-pin devices (three on each side). 
However, there are pads between the silk screen layouts giving the user two 52-pin (2×26) 
SOIC layouts with 50 mil pin spacing. There are six sets of pads that can be used for 3- to 
6-pin SOT23 packages. There are also 60 sets of pads that can be used for SMT resistors 
and capacitors in an 0805 SMT package. Each component has every one of its pin pads 
connected to a hole in which a 30 AWG wire can be soldered (standard wire wrap wire can 
be soldered in for point-to-point wiring on the Prototyping Board). Because the traces are 
very thin, carefully determine which set of holes is connected to which surface-mount pad.

There is also a space above the space for the RS-232 transceiver that can accommodate a 
large surface-mounted SOIC component.
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B.3.2  Attach Modules to Prototyping Board

Turn the RCM2200 module so that the Ethernet connector end of the module extends to 
the right, as shown in Figure B-7 below. Align the module headers J4 and J5 into sockets 
J1 and J2 (the MASTER slots) on the Prototyping Board. Press the module’s pins firmly 
into the Prototyping Board headers.

Figure B-7.  Install the RCM2200 on the Prototyping Board

NOTE: It is important that you line up the pins of the module headers exactly with the 
corresponding pins on the Prototyping Board. The header pins may become bent or 
damaged if the pin alignment is offset, and the module will not work. Permanent elec-
trical damage to the module may also result if a misaligned module is powered up.
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With the RCM2200 plugged into the MASTER slots, it has full access to the RS-232 trans-
ceiver, and can act as the “master” relative to another RabbitCore RCM2200 or RCM2300 
plugged into the SLAVE slots, which acts as the “slave.”

This master/slave relationship is not used in the DeviceMate Development Kit where the 
“target” RCM2300 is plugged into the MASTER slots, and the RCM2200, which is used 
as the DeviceMate hardware platform, is plugged into the SLAVE slots. The special Dem-
onstration Board serves only as a means to connect the two RabbitCore modules together 
to demonstrate the DeviceMate software features in Dynamic C.
40 RabbitCore RCM2200



APPENDIX C.  POWER SUPPLY

Appendix C provides information on the current requirements of
the RCM2200, and includes some background on the chip select
circuit used in power management.

C.1  Power Supplies

The RCM2200 requires a regulated 5 V ± 0.25 V DC power source. The RabbitCore 
design presumes that the voltage regulator is on the user board, and that the power is made 
available to the RabbitCore board through headers J4 and J5. 

An RCM2200 with no loading at the outputs operating at 22.1 MHz typically draws 134 mA. 
The RCM2200 will consume an additional 10 mA when the programming cable is used to 
connect the programming header, J1, to a PC.

C.1.1  Battery-Backup Circuits

The RCM2200 does not have a battery, but there is provision for a customer-supplied bat-
tery to back up SRAM and keep the internal Rabbit 2000 real-time clock running.

Header J5, shown in Figure C-1, allows access to the external battery. This header makes 
it possible to connect an external 3 V power supply. This allows the SRAM and the inter-
nal Rabbit 2000 real-time clock to retain data with the RCM2200 powered down.

Figure C-1.  External Battery Connections 
at Header J5

A lithium battery with a nominal voltage of 3 V and a minimum capacity of 165 mA·h is 
recommended. A lithium battery is strongly recommended because of its nearly constant 
nominal voltage over most of its life.
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The drain on the battery by the RCM2200 is typically 16 µA when no other power is sup-
plied. If a 950 mA·h battery is used, the battery can last more than 6 years:

The actual life in your application will depend on the current drawn by components not on 
the RCM2200 and the storage capacity of the battery. Note that the shelf life of a lithium ion 
battery is ultimately 10 years. The RCM2200 does not drain the battery while it is powered 
up normally.

The battery-backup circuit serves three purposes:

• It reduces the battery voltage to the SRAM and to the real-time clock, thereby limiting 
the current consumed by the real-time clock and lengthening the battery life.

• It ensures that current can flow only out of the battery to prevent charging the battery.

• A voltage, VOSC, is supplied to U6, which keeps the 32.768 kHz oscillator working 
when the voltage begins to drop.

VRAM and Vcc are nearly equal (<100 mV, typically 10 mV) when power is supplied to 
the RCM2200.

Figure C-2 shows the RCM2200 battery-backup circuit.

Figure C-2.  RCM2200 Battery-Backup Circuit

C.1.2  Reset Generator

The RCM2200 uses a reset generator, U1, to reset the Rabbit 2000 microprocessor when the 
voltage drops below the voltage necessary for reliable operation. The reset occurs between 
4.50 V and 4.75 V, typically 4.63 V. The RCM2200 has a reset output, pin 9 on header J5.

950 mA·h
16 µA

------------------------ 6.8 years.=
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C.2  Chip Select Circuit

The RCM2100 has provision for battery backup, which kicks in to keep VRAM from 
dropping below 2 V.

When the RCM2200 is not powered, the battery keeps the SRAM memory contents and 
the real-time clock (RTC) going. The SRAM has a powerdown mode that greatly reduces 
power consumption. This powerdown mode is activated by raising the chip select (CS) 
signal line. Normally the SRAM requires Vcc to operate. However, only 2 V is required 
for data retention in powerdown mode. Thus, when power is removed from the circuit, the 
battery voltage needs to be provided to both the SRAM power pin and to the CS signal 
line. The CS control switch accomplishes this task for the CS signal line.

Figure C-3 shows a schematic of the chip select control switch.

Figure C-3.  Chip Select Control Switch

In a powered-up condition, the CS control switch must allow the processor’s chip select 
signal /CS1 to control the SRAM’s CS signal /CSRAM. So, with power applied, /CSRAM 
must be the same signal as /CS1, and with power removed, /CSRAM must be held high 
(but only needs to be as high as the battery voltage). Q3 and Q4 are MOSFET transistors 
with opposing polarity. They are both turned on when power is applied to the circuit. They 
allow the CS signal to pass from the processor to the SRAM so that the processor can peri-
odically access the SRAM. When power is removed from the circuit, the transistors will 
turn off and isolate /CSRAM from the processor. The isolated /CSRAM line has a 100 kΩ 
pullup resistor to VRAM (R28). This pullup resistor keeps /CSRAM at the VRAM voltage 
level (which under no power condition is the backup battery’s regulated voltage at a little 
more than 2 V).

Transistors Q3 and Q4 are of opposite polarity so that a rail-to-rail voltages can be passed. 
When the /CS1 voltage is low, Q3 will conduct. When the /CS1 voltage is high, Q4 will 
conduct. It takes time for the transistors to turn on, creating a propagation delay. This 
delay is typically very small, about 10 ns to 15 ns.
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APPENDIX D.  SAMPLE CIRCUITS

This appendix details several basic sample circuits that can be
used with the RCM2200 modules.

• RS-232/RS-485 Serial Communication

• Keypad and LCD Connections

• External Memory

• D/A Converter
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D.1  RS-232/RS-485 Serial Communication

Figure D-1.  Sample RS-232 and RS-485 Circuits

Sample Program: PUTS.C in SAMPLES\RCM2200.
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D.2  Keypad and LCD Connections

Figure D-2.  Sample Keypad Connections

Sample Program: KEYLCD.C in SAMPLES\RCM2200.

Figure D-3.  Sample LCD Connections

Sample Program: KEYLCD.C in SAMPLES\RCM2200.
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D.3  External Memory

The sample circuit can be used with an external 64K memory device. Larger SRAMs can 
be written to using this scheme by using other available Rabbit 2000 ports (parallel ports 
A to E) as address lines.

Figure D-4.  Sample External Memory Connections

Sample Program: EXTSRAM.C in SAMPLES\RCM2200.
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D.4  D/A Converter

The output will initially be 0 V to -10.05 V after the first inverting op-amp, and 0 V to 
+10.05 V after the second inverting op-amp. All lows produce 0 V out, FF produces 10 V 
out. The output can be scaled by changing the feedback resistors on the op-amps. For 
example, changing 5.11 kΩ to 2.5 kΩ will produce an output from 0 V to -5 V. Op-amps 
with a very low input offset voltage are recommended.

Figure D-5.  Sample D/A Converter Connections
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APPENDIX E.  PROGRAMMING CABLE

Appendix E provides additional theoretical information for the Rabbit

2000™ microprocessor when using the DIAG and PROG connectors on
the programming cable. The PROG connector is used only when the
programming cable is attached to the programming connector (header
J5) while a new application is being developed. Otherwise, the DIAG
connector on the programming cable allows the programming cable to
be used as an RS-232 to CMOS level converter for serial communica-
tion, which is appropriate for monitoring or debugging a RabbitCore
system while it is running.
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The programming port, which is shown in Figure E-1, can serve as a convenient communica-
tions port for field setup or other occasional communication need (for example, as a diag-
nostic port). If the port is simply to perform a setup function, that is, write setup 
information to flash memory, then the controller can be reset through the programming 
port and a cold boot performed to start execution of a special program dedicated to this 
functionality.

Figure E-1.  Programming Port Pin Assignments

When the PROG connector is used, the /RESET line can be asserted by manipulating 
DTR and the STATUS line can be read as DSR on the serial port. The target can be 
restarted by pulsing reset and then, after a short delay, sending a special character string at 
2400 bps. To simply restart the BIOS, the string 80h, 24h, 80h can be sent. When the 
BIOS is started, it can tell whether the programming cable is connected because the 
SMODE1 and SMODE0 pins are sensed as being high.

Alternatively, the DIAG connector can be used to connect the programming port. The 
/RESET line and the SMODE1 and SMODE0 pins are not connected to this connector. 
The programming port is then enabled as a diagnostic port by polling the port periodically 
to see if communication needs to begin or to enable the port and wait for interrupts. The 
pull-up resistors on RXA and CLKA prevent spurious data reception that might take place 
if the pins floated.

If the clocked serial mode is used, the serial port can be driven by having two toggling 
lines that can be driven and one line that can be sensed. This allows a conversation with a 
device that does not have an asynchronous serial port but that has two output signal lines 
and one input signal line.

The line TXA (also called PC6) is zero after reset if the cold-boot mode is not enabled. A 
possible way to detect the presence of a cable on the programming port is for the cable to 
connect TXA to one of the SMODE pins and then test for the connection by raising PC6 
(by configuring it as a general output bit) and reading the SMODE pin after the cold-boot 
mode has been disabled. The value of the SMODE pin is read from the SPCR register.
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Once you establish that the programming port will never again be needed for program-
ming, it is possible to use the programming port for additional I/O lines. Table E-1 lists the 
pins available for this alternate configuration.
 

Table E-1.  RCM2200 Programming Port Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes

H
ea

de
r 

J1

1 RXA Serial Port A PC7—Input

2 GND

3 CLKA
PB1—Bitwise or parallel 
programmable input

4 VCC

5 RESET
Connected to reset 
generator U1

6 TXA Serial Port A PC6—Output

8 STATUS Output

9 SMODE0 Input
Must be low when 
RCM2200 boots up

10 SMODE1 Input
Must be low when 
RCM2200 boots up
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NOTICE TO USERS

Z-WORLD PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE-
SUPPORT DEVICES OR SYSTEMS UNLESS A SPECIFIC WRITTEN AGREEMENT REGARDING 
SUCH INTENDED USE IS ENTERED INTO BETWEEN THE CUSTOMER AND Z-WORLD PRIOR 
TO USE. Life-support devices or systems are devices or systems intended for surgical implantation into the 
body or to sustain life, and whose failure to perform, when properly used in accordance with instructions for 
use provided in the labeling and user’s manual, can be reasonably expected to result in significant injury.

No complex software or hardware system is perfect. Bugs are always present in a system of any size. In 
order to prevent danger to life or property, it is the responsibility of the system designer to incorporate 
redundant protective mechanisms appropriate to the risk involved.

All Z-World products are 100 percent functionally tested. Additional testing may include visual quality con-
trol inspections or mechanical defects analyzer inspections. Specifications are based on characterization of 
tested sample units rather than testing over temperature and voltage of each unit. Z-World products may 
qualify components to operate within a range of parameters that is different from the manufacturer’s recom-
mended range. This strategy is believed to be more economical and effective. Additional testing or burn-in 
of an individual unit is available by special arrangement.
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SCHEMATICS

090-0120 RCM2200 Schematic
www.rabbitsemiconductor.com/documentation/schemat/090-0120.pdf

090-0122 RCM2200 Prototyping Board Schematic
www.rabbitsemiconductor.com/documentation/schemat/090-0122.pdf

090-0128 Programming Cable Schematic
www.rabbitsemiconductor.com/documentation/schemat/090-0128.pdf

The schematics included with the printed manual were the latest revisions available at the 
time the manual was last revised. The online versions of the manual contain links to the 
latest revised schematic on the Web site. You may also use the URL information provided 
above to access the latest schematics directly.
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